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Using Press-to-Test

The guidelines for many international, national, and state assessments allow or
require students to use TI-Nspire™ handhelds when taking an exam. Press-to-Test
enables you to quickly prepare student handhelds for exams where use of applications,
programs, and other files is restricted. When a handheld is in Press-to-Test mode,
students cannot access pre-existing folders, documents, and Scratchpad data. Students
using the TI-Nspire™ CX-C handhelds cannot access the Chinese-English dictionary.

Press-to-Test temporarily disables documents and some features of handheld
applications. After the exam, these documents and features can be easily restored for
classroom use.

The Press-to-Test feature is available on the following TI-Nspire™ handhelds:

e TI-Nspire™ and TI-Nspire™ CAS handhelds with OS version 1.3 or higher.

e TI-Nspire™ CX and TI-Nspire™ CX CAS handhelds with OS version 3.0 or higher.

e TI-Nspire™ CX-C and TI-Nspire™ CX-C CAS handhelds with OS version 3.1 or higher.

e TI-Nspire™ CM-C and TI-Nspire™ CM-C CAS handhelds with OS version 3.1 or
higher.

Press-to-Test is also available in TI-84 Plus Mode when using a TI-Nspire™ handheld
that lets you switch between the TI-Nspire™ keypad and a TI-84 Plus keypad. For
details, see Press-to-Test for TI-84 Plus Mode.

Note: Some states only permit the use of the TI-Nspire™ in TI-84 mode. To find out if
your state allows TI-Nspire™ technology, see the State/Province Information website
at: education.ti.com/go/testprep

Entering Press-to-Test Mode

1. Ensure that the handheld is turned off.
2. Ona Touchpad, press and hold down the keys.

On a Clickpad: Press and hold down the @ Go keys.

Do not release the keys until the Press-to-Test screen is displayed.
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| |Press—to-Test (CAS)

Prevent access to pre—existing content

Restrictions (Ctrl + A to checki/uncheck ally

Limit geometry functions

M Disable function and conic grab and
move

(7] Enter Press-to-Test|||Cancel

Select an Angle Setting

1. Press as necessary to highlight the Angle Setting menu.

2. Press P> to display the list of angle units. Available units are: degree, radian, and
gradian.

3. Press A or V¥ to highlight the angle unit you wish to use, and then press to
select it.

Select or Clear Restrictions

By default, all restrictions are selected. You can set each restriction individually, or you
can quickly select or clear all restrictions by pressing [ctn] [A].

e Selecting a restriction disables or limits specific features during the Press-to-Test
session.

e C(learing a restriction allows its associated features to be used during the session.

Note: For a detailed list of restrictions, refer to Understanding Press-to-Test
Restrictions

1. Press or press ¥ to move through the list of restrictions. To quickly access the
last item in the list, press A. Continue to press A to move up through the list of
restrictions.

2. When a restriction is highlighted, press to clear or select it.
Enter Press-to-Test Mode

Note: You cannot change the restrictions after entering Press-to-Test mode. You must
exit Press-to-Test and then enter it with new settings. To cancel now without entering

Press-to-Test mode, press [esc], or press to select Cancel, and then press [enter].

1. To proceed and enter Press-To-Test using the current settings, press to select
Enter Press-to-Test, and then press [enter].
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The handheld saves the settings and then restarts. When the restart has
completed, the following dialog box is displayed to confirm the handheld is in
Press-to-Test mode.

Note: Your handheld display may be different, depending on whether you modified
the settings. You cannot change settings after the handheld restarts.

Press—to-Test (CAS)

This handheld is in Press—to-Test mode.
Pre—existing content is disabled.

| |B

Angle Setting: Degree
Restrictions include:
] Limit geometry functions

Disable function and conic grab and

Mwe

d |Transfer Fress—to-Test.

2. Press (] or to select OK.

The Home screen opens. A Lock icon in the title bar indicates the handheld is in
Press-to-Test mode.

Calculate
B! Graph

Y

- Pre-existing Scratchpad data is temporarily deleted.

- Pre-existing documents and folders within the My Documents folder are
temporarily deleted.

Note: Pre-existing documents, folders, and Scratchpad data will be restored
when you exit Press-to-Test mode.

- A “Press-to-Test” folder is created within the My Documents folder.
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- If CAS functionality is enabled on the handheld, the "CAS" identifier is displayed
on the Home screen.

- The Chinese-English dictionary, if installed, is temporarily disabled on
TI-Nspire™ CX-C handhelds.

Accessing Press-to-Test Help
> Use one of the following methods to get help for using Press-to-Test:

e From the Press-to-Test window, click the Help button @ located in the lower
left corner.

From an open document on a Touchpad: Press [docv], and then select Press-to-
Test > Help.

From an open document on a Clickpad: Press @) (@on), and then select Press-
to-Test > Help.

The Help window opens.
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I How to set-up your handheld:|

If wiou are using a Touchpad keypad, to put
wour handheld in Press-to—-Test mode, tum
wour handheld OFF, then hold down ESC and
OM at the same time.

If wou are using a Clickpad keypad, to put yvour

handhald in Procc—tn—Tact rnda fum wannre

[£4| — ]}

Clearing Data in Press-to-Test Mode

You can clear documents, Scratchpad data, and libraries added in a Press-to-Test
session without exiting Press-to-Test mode. Clearing data does not change the Press-
to-Test restrictions, so you can use this method to start a new test that requires the
same restrictions.

Note: To change restrictions, you must exit Press-to-Test and then enter Press-to-Test
mode with new settings.

To clear Press-to-Test data without changing restrictions:
1. Ensure the handheld is turned off.

2. Ona Touchpad, turn on the handheld by pressing and holding down the
keys.

On a Clickpad: Press and hold down the @) keys.
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The Press-to-Test window is displayed with an option to Reset.

|Press—to-Test (CAS)

This handheld is in Press—to—-Test mode.
Pre—existing content is disabled.

Angle Setting: Degree
Restrictions include:

[] Limit georetry functions

Disable function and conic grab and
[
Mnwe

(7] |Reset Press-to-Test

3. Select Reset Press-to-Test to clear the data.

- Or -

Select OK to close the window without clearing the data.
Note for TI-Nspire™ handhelds with removable keypad: Clearing Press-to-Test data
while using the TI-Nspire™ keypad does not affect data created with the TI-84 Plus

keypad. Your TI-84 Plus data remains intact, although it is not accessible while the
TI-Nspire™ keypad is in place.

Reviewing Press-to-Test Mode Restrictions

You can review the Angle Setting and restrictions in effect on a handheld that is in
Press-to-Test mode. You cannot change the restrictions while in the testing session.
You must exit Press-to-Test mode and re-enter it with new restrictions.

To review the current restrictions:
1. Turn the handheld off, and then turn it back on.

A dialog box opens, showing the selected Press-to-Test settings.

[3]

This handheld is in Press-to-Test mode.
Pre-existing content is disabled.

Angle Setting: Degree
Restrictions include:
[] Limit geometry functions

Disable function and conic grab and

Mowe

HE

(7] Transfer Press—to—Test.l 0
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2. Press A or V¥ to scroll through the restrictions.

Restrictions that are currently in effect are shown with a check mark.

Operating the Handheld in Press-to-Test Mode

When a handheld is in Press-to-Test mode, the LED indicator on top of the handheld
flashes (on the TI-Nspire CX and Touchpads). The LED lets you quickly see that the
handheld is in Press-to-Test mode—even when the handheld is off.

e If the LED indicator flashes green-green, all restrictions are selected.

e If the LED indicator flashes yellow-yellow, one or more restrictions have been
cleared.

Notes:

e Older TI-Nspire™ CAS handhelds do not have an LED indicator on the top of the
handheld.

e The LED on the TI-Nspire™ CM-C handheld indicates battery status only. It does not
flash when the handheld is in Press-to-Test mode.

System Settings

The system settings in effect prior to entering Press-to-Test mode are not passed to
the Press-to-Test session. Instead, when you first enter Press-to-Test mode, the
system settings are set to their defaults. You can change the settings while in Press-to-
Test mode. When you exit Press-to-Test mode, system settings are restored to those in
effect before you entered Press-to-Test.

Freeing Memory for Press-to-Test Mode

If your handheld has insufficient memory available to enter Press-to-Test mode, a
message appears suggesting that you remove some documents.

Your options include:

e Backing up documents to a computer or another handheld and then deleting them
from your handheld. You can restore the documents after you exit Press-to-Test
mode.

e Deleting unnecessary documents from your handheld.

For detailed instructions on freeing memory, refer to the "Memory and File
Management" section of the Getting Started guide for your handheld.

Turning the Handheld Off and On in Press-to-Test Mode

If you turn the handheld off, or if it goes into Automatic Power Down™ (APD™) while in
the Press-to-Test mode, it remains in testing mode when powered on again. A
message reminds you that the handheld is in Press-to-Test mode, and the selected
restrictions are shown.
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Fress-to-Test

This handheld is in Fress—to-Test mode. =
Fre-existing content is disabled.
Angle Setting: Degree
Restrictions include:
[] Limit geometry functions
Disable function and conic grab and
mowve
7] TransferPress—to—Test.l

Note: If a dialog box is open when the handheld powers down while in Press-to-Test
mode, that dialog box is displayed when you turn the handheld on again.

Auto-Save

If the handheld restarts while in Press-to-Test mode, the handheld remains in testing
mode and returns to the last active document.

Managing Battery Power

If using a TI-Nspire™ or TI-Nspire™ CAS handheld, you can remove and replace
batteries while in Press-to-Test mode. If you change the batteries, the handheld
remains in testing mode. When you turn it on again, the reminder dialog box is
displayed.

Before entering Press-to-Test mode or before beginning an exam, you should ensure
the rechargeable battery is fully charged on any handheld that uses a rechargeable
battery.

Working with Documents in Press-to-Test Mode

When the handheld is in Press-to-Test mode, all folders and documents present on the
handheld before you entered Press-to-Test mode are disabled. While in Press-to-Test
mode, you will only see the Press-to-Test folder listed in My Documents.

Teachers can send and collect documents when handhelds are in Press-to-Test mode.
However, if you want to collect a document that students have created or edited while
in Press-to-Test mode, you must collect the document before the students exit Press-
to-Test mode.

Accessing the Press-to-Test Folder

1. Press to access the Home screen.

On a Clickpad: Press (@).

2. Select My Documents to open the file manager.
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You can create, save, or delete folders and documents within the Press-to-Test folder.

Creating a New Document

1. Press to access the Home screen.
On a Clickpad: Press (@).

2. Select New Document or press [ctrl] [N] to open a new document.

3. Use V¥ and A to highlight the application you want to add to the page, and then
press [enter].,

A lock icon in the title bar indicates that the handheld is in Press-to-Test mode.

1.1 0

O rr (x)=|

-6.67

Transferring Press-to-Test Restrictions

Use the Transfer Press-to-Test feature to quickly distribute a specific set of
Press-to-Test restrictions to multiple student handhelds without requiring a computer.
Requirements

e If you send Press-to-Test settings to a handheld that is already in Press-to-Test
mode, the restriction settings on the receiving handheld are overwritten and all
data created during that Press-to-Test session is lost.

e The operating system version on the sending handheld must be equal to or higher
than the OS on the receiving TI-Nspire™ handheld.

e The transfer will fail if the receiving handheld does not have enough memory.

12 Using Press-to-Test



Transferring the Settings

1. Enter Press-to-Test mode on the "sending" handheld. Be sure to select the specific
set of restrictions required for the exam.

2. Connect the sending handheld to a "receiving" handheld using a mini-to-mini USB
cable.

TI-72spire cx n-nspire cx

) . y

3. Make sure both handhelds are turned on and the Press-to-Test window is visible on
the sending handheld. If necessary, turn the handheld off, and then turn it on again.

Fress-to-Tes

This handheld is in Press—to-Test mode. =
Pre-existing content is disabled.
Angle Setting: Degree
Restrictions include:
[] Limit geometry functions
Disable function and conic grab and
mowve
@j TransferPress—to—Test.l
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4. Select Transfer Press-to-Test.

The Press-to-Test Angle Setting and Restrictions are copied to the receiving
handheld.

When the transfer is complete, the receiving handheld restarts in Press-to-Test
mode, and the sending handheld displays a confirmation message.

1 Press-to-Test

This handheld is in Press-to-Test mode.

Transfer Press—-to-Test

Transfer completed. “ou can unplug and
connect to another handheld.

=

|T|ansfe| FPress-to-Test

Note: Both handhelds can now be used as sending handhelds.

5. Connect the next receiving handheld, and repeat from Step 3 until all handhelds are
configured.

Exiting Press-to-Test Mode
When you exit Press-to-Test mode on a handheld:

e All documents created during the Press-to-Test session are deleted. If you re-enter
Press-to-Test mode, the Press-to-Test folder is empty.

e All files and system settings are restored to what they were before you entered
Press-to-Test mode.

e If a document was open before you entered Press-to-Test mode, that document is
restored to the same view (My Documents, Page sorter, or page view) as before. If
the document contained unsaved changes, the changes remain unsaved.

¢ If no document was open, the handheld displays the My Documents folder.
Using Another Handheld to Exit Press-to-Test Mode

You can exit Press-to-Test mode on your handheld by connecting it to another handheld
and using the Exit Press-To-Test menu command. The two handhelds can be mixed. For
example, you can connect a TI-Nspire™ CX handheld to a TI-Nspire™ handheld or
connect a TI-Nspire™ CAS handheld to a handheld that does not have CAS.

Important: If the other handheld is in Press-to-Test mode, it will also exit Press-to-Test.

1. Connect your handheld to the other handheld using the unit-to-unit connection
cable.
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2. Make sure both handhelds are turned on.

3. Onvyour handheld, press to display the Home screen.
On a Clickpad: Press @
4. Select My Documents, and then press to display the Documents menu.

On a Clickpad: Select My Docs, and then press (o) (@P).

5. On the Documents menu, select Press-to-Test > Exit Press-To-Test. This menu item
is enabled only in Press-to-Test mode.

Documents
File »
Edit »
Wi 2
b
»

Insert
FPage Layout

. Refresh Libraries
 Seftings & Status p
:Login...

: Press-to-Te| -
2: Transfer Press—to-Test

3 Help

< e B I

2]

e Your handheld exits Press-to-Test mode and restarts in normal mode. If the
other handheld is in Press-to-Test mode, it also exits Press-to-Test mode and
restarts.

e If the handheld is not connected properly, it displays the following message.

Exit Press—to-Test

Connectivity Error: Check that both
TI-MNspire™ handhelds are turned ON, connect
your TI-Nspire™ handheld to another
TI-Mspire™ handheld and try again.

e The handheld does not exit Press-to-Test mode until it restarts. If you
disconnect the cable before the restart begins, the handheld remains in Press-
to-Test mode.

Note: You can also exit Press-to-Test mode by successfully receiving an OS upgrade
(from another handheld or through computer software). Receiving the same OS
version will not cause the handheld to exit Press-to-Test.
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Canceling Press-To-Test on Multiple Handhelds

Teachers running TI-Nspire™ Navigator™ Teacher Software can cancel Press-to-Test
mode remotely on multiple handhelds. The handhelds must be turned on and
connected to the teacher's computer by one of these means:

TI-Nspire™ Docking Station or TI-Nspire™ CX Docking Station
TI-Nspire™ Navigator™ Cradle
TI-Nspire™ CX Wireless Network Adapter

A direct connection through a standard USB cable

Note: TI-Nspire™ CX Navigator™ Teacher Software v4.2 can cancel Press-to-Test mode
on CX handhelds only. To cancel Press-to-Test on both CX and earlier handhelds, you
must use TI-Nspire™ Navigator™ Teacher Software v3.9.

Canceling by Using the Transfer Tool

1.

Create an empty .tns file named “Exit Test Mode. tns” and save it in your
default TI-Nspire™ folder.

Note: The file name is case sensitive and must be named as described.
In the Content Workspace, select Tools > Transfer Tool.
The Transfer Tool opens.

Click Add to Transfer List.

Navigate to the folder where the "Exit Test Mode.tns" file is located, and select it
to add it to the transfer list.

In the Transfer Tool, select the Exit Test Mode.tns file.

The Edit Destination Folder field becomes active when you select the file name.
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% Transfer Tool

setup | Status |

l Add to Transfer List I I Remove Selected J ["] Delete all files and folders before transfer
File Mame Destination Folder Size
[=EMEvit Test Mode.tns [E=RTransfers-11-9-11

Edit Destination Folder: [Press-to-Test -] |- Change

Start Transfer Close

6. Type Press-to-Test in the Edit Destination Folder field, and click Change.

Note: You must type the folder name manually. You cannot select it by navigating
to the handheld's Press-to-Test folder.

7. Click Start Transfer.

The “Exit Test Mode.tns” file is sent to the connected handhelds, and Press-to-Test
is canceled. The handhelds restart, and the operating system loads.

To cancel Press-to-Test mode on additional handhelds, disconnect the restarted
handhelds and connect the other handhelds. The transfer process continues until
you stop the transfer.

8. To stop the transfer, click Stop Transfer.

9. Click Close when all transfers are complete.
Canceling by Using Send to Class

When a class is in session and students are logged in, you can cancel Press-to-Test by
sending the "Exit Test Mode.tns" file to the class. Students not logged in will receive
the file when they log in.

1. Create an empty .tns file named “Exit Test Mode. tns” and save it in your
default TI-Nspire™ folder.

Note: The file name is case sensitive and must be named as described.
2. Click Tools > Send to Class.

The Select file(s) to send dialog box opens.
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Ensure the Files tab is open.
Navigate to the folder where the "Exit Test Mode.tns" file is located and select it.

Click Next.

The Select individual(s) dialog box opens.

Step 2 of 2 - Select individual(s) 2. |

Finger, Debbie

Class

8

Individuals

Send to handheld folder. |Press-to-Test =
D Logged in only

| = Back | Finish H Cancel |

6. Click Class to send the file to the whole class. To send the file to only those

class members who are currently logged in, select the Logged in only check box.

Note: To send the file to an individual student, click Individuals &, and then click

the student name.
Type Press-to-Test in the Send to handheld folder field.
Click Finish.

For students who are logged in, the “Exit Test Mode.tns” file is sent, and the
connected handhelds exit Press-to-Test mode. The handhelds restart and the
operating system loads.

Understanding Press-to-Test Restrictions

By default, all restrictions are selected when you enter Press-to-Test mode, and their
associated features are disabled on the application menus.

e Selecting a restriction disables or limits its associated features during the Press-to-
Test session.

e Clearing a restriction allows its associated features to be used during the session.
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Restricting Geometry Functions

When you choose to limit geometry functions, all items on the Measurement,
Construction, and Transformation menus are disabled.

Restricting Graphs Functions
On the Graphs menu, the following items are disabled:

e Actions > Coordinates and Equations

e Geometry > Measurement, Construction, and Transformation.

Disabling Function and Conic Grab and Move

* You cannot move any function or conic in Graphs, Geometry, or Scratchpad. For
example, if you have graphed y:x3, you can select the function but you cannot
move or manipulate it by dragging.

* You cannot access the attribute that toggles the displayed form of a conic equation
between Standard and Expanded.

e Disabling function and conic grab and move does not apply to lines and functions in
Data & Statistics.

e Disabling function grab and move does not restrict sliders in the Graphs and
Geometry applications.

e You can still grab the coordinate plane and move it around.

Disabling Vector Functions

When vector functions are disabled, students cannot calculate the following functions:
e Unit vector [unitV(]

e Cross product [crossP(]

e Dot product [dotP(]

e Eigenvector [eigVc(]

e Eigenvalue [eigVI(]

Disabling the “isPrime” Function

The isPrime( function determines if a number is a prime number (a whole number
greater than two that is evenly divisible only by itself and one). Disabling this function
prevents students from selecting the isPrime( command in the Catalog and from
selecting Test > IsPrime in Math Operators. If a student manually enters the isPrime(
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function, submitting the expression results in an error message.
Disabling Differential Equation Functionality

The Differential Equation graph type is disabled in the Graphs and Geometry
applications. Users cannot manually type and graph a differential equation.

Related math functions rk23(, euler(, and deSolve( are also disabled.
Disabling Inequality Graphing

When inequality graphing is disabled, students cannot graph inequalities with <, >, <,
and > or grab and drag inequalities to a graph in the Graphs, Geometry, and
Scratchpad applications.

Disabling 3D Graphing
When this feature is disabled, students cannot use the 3D Graphing view.
Disabling Implicit Graphing, Conic Templates, Conic Analysis, and Geometric Conics

When these features are disabled, students cannot graph equations in terms of

X =ay + corax + by = c. Conic templates are not available, and students cannot
analyze conics or graph the geometric conic of an ellipse, parabola, hyperbola, or conic
by five points.

Disabling Trigonometric Functions

Disabling trigonometric functions prevents students from using the following functions
in calculations and graphing.

csc sec cot
-1 -1 -1
csc™, arcesc sec™™, arcsec cot™, arccot
csch sech coth

csch'l, arccsch

sech'l, arcsech

coth'l, arccoth

e Attempting to evaluate any of these functions results in an error message.

e Students cannot select the csc, sec, cot, csc-1, sec-1, and cot-1 functions by pressing
on the handheld.

e Students cannot select the disabled functions from the Catalog.
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Disabling the Iogbx Template

Students cannot use the log, x (convert to logbase) and log(a, b) commands and
templates, including Iogbx templates.

e When a students presses log. on the handheld, only calculations in log10 format
are accepted.

e If a student manually enters log(a,b) or >logbase( into an expression, attempting to
evaluate the expression results in an error message.

e Students are allowed to enter log(a), log(a,10), and log(a,10.).

Disabling Summation Functions and Templates

Students are prevented from using summation functions and templates. The 3( and
sumSeq( functions are disabled.

Disabling Polynomial Root Finder

The polyRoots(, cPolyRoots(, solve(, simult(, zeros(, and cZeros( functions are disabled.
Attempting to evaluate any of these functions results in an error message.

Note: When the polynomial tools are disabled, students cannot use Find Roots of
Polynomial, Real Roots of Polynomial, or Complex Roots of Polynomial.

Disabling Simultaneous Equation Solver

The linSolve( and simult( functions are disabled in menus and in the Catalog.
Attempting to evaluate either of these functions results in an error message.

Disabled Chinese-English Dictionary

In Press-to-Test mode, the Chinese-English Dictionary is automatically disabled if
installed on TI-Nspire™ CX-C handhelds. You cannot use the dictionary while in Press-
to-Test mode.

Press-to-Test for TI-84 Plus Mode

The information in this section applies only to TI-Nspire™ handhelds that let you switch
between the TI-Nspire™ keypad and a TI-84 Plus keypad. To use Press-to-Test in
TI-84 Plus mode, the handheld must be started with the TI-84 Plus keypad in place.

Note: Using Press-to-Test in TI-84 Plus mode does not affect documents created with
the TI-Nspire™ keypad in place.

Be sure to exit Press-to-Test mode before attempting to switch to a different keypad.
If you switch keypads while in Press-to-Test mode, the handheld displays the following
message:
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Unzaved Document 1] ]

MName | Size
O Unsaved Document
LF:‘! Crace—Tn—Tact [al"4

This key pad is not compatible with the current
Press to Test mode. Please revert to the key
pad used when entering Press to Test mode.

Enabling Press-to-Test Mode in TI-84 Plus Mode
1. Turn the handheld off.
2. Press and hold [, 0] and until the Reset Options screen opens.

RESET OFTION:

DIZAELE AFFZEs FROGRAME

ANGLE: RRDIAN [0S
ZTRT DIAGNOSTICE: [ff] OFF
DIZAELE 1¢3eRZE: {3 no
DIZRELE Zi: {3 no

[EsC)  [OH )

By default, the angle mode is set to DEGREE, Stat Diagnostics are ON, and the
functions logBASE and summation (X) are disabled.

3. To change the default settings, move the cursor over the desired setting and press

ENTER].
4. Press [Z00M] (beneath OK on the screen) to select OK.

The options you selected are displayed on the Reset Complete screen.

DIZAELE AFFZ: FROGRAHE
ANGLE: DEGREE

ZTAT DIAGNOETICE: ON
DIZAELE T1o3ERZE: YES
DIZAELE Zi: YEZ

KANis REZET

Frassan Hg...

Press any key to continue.

To verify that Apps, Programs, and functions are disabled:
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Press [APPS

AFFS HAYE EEEN
DIZAELED

LINK-RECEIYE L1 (OF ADY
FILEY TO RE:TOKE

Fress any Hew...

Press [PRGM
FROGKEAM: HAYE EEEN
DIZAELED
LINK-KECEINE L1 <OF AOY
FILEY TO REXTORE
Fress any Hew...
Press [ALPHA] [F2]
Press |MATH

a MUM CFPx FEE

in
fMaxy

nberiwe
fhlinty
St —
A:leoRRSE——
Heoluwer..

00

Other variables stored in RAM and in archived memory (including AppVars) are

deleted.

Verifying that Functions are Disabled in TI-84 Plus Mode

When students try to access disabled functions, the following informational screens

are displayed:
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To3BRZEC HAZ EEEN suramatisn Z0 HRAS EEEN

DIZAELED DIZAELED
LINK-KECEIVE L1 Ok AOY LINK-KECEINE L1 <OF ARY
FILE) TO KE:TORE FILE} TO RKEXTORE

Fressan ey, Fressan Hev...

Note: If a handheld is already in Press-to-Test mode, applications and programs are
disabled. If you try to enter Press-to-Test on a TI-Nspire™ handheld using the TI-84
keypad while already in Press-to-Test mode, the Reset Complete screen is displayed.
Current settings are shown and RAM is reset. The handheld is ready to be used by
another student in a clean testing state as needed.

REXET COHWFLETE
DIZAELE AFFZs FEOGRANZ
ANGLE: DEGKEE
ETAT DIAGNOZTICE: ON
DIZAELE 103ERZE: YEX
DIFAELE Ei: YE*
FAHisKESET
Fressan Hey...

Exiting Press-to-Test Mode in TI-84 Plus Mode

When you re-enable TI-Nspire™ handhelds using the TI-84 keypad and TI-84 Plus
handhelds, Apps and Programs are restored.

To restore a TI-Nspire™ handheld in TI-84 Plus mode to full functionality:

e Link your handheld to another TI-Nspire™ handheld in TI-84 Plus mode or a TI-84
Plus handheld.

e Transfer any file to or from the handheld that is in testing mode.

e Alternatively, you can use Tl Connect™ to download a file from your computer to
your handheld.

To transfer a file from another TI-84 Plus handheld:

1. On the receiving unit, press [LINK] and then highlight RECEIVE. Do not press
ENTER| yet.

2. On the sending calculator, Press [LINK].

3. Select a file to send by selecting a category, and then selecting a file to send.

24 Using Press-to-Test



?;gf FECEIVE TRAHSHIT
sHIL1+.. m [ LIST
ZEAL11-... = Lz LIST
S5 Prdm.., P Lz LIST
EHLi=t.. Ly LIST

iLists to TISZ. Le LIST
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4. Highlight TRANSMIT to send the file, but do not press [ENTER] yet.

SELECT IIEEIiEiIII
iHTransm1

5. Press [ENTER] on the receiving calculator.
6. Press [ENTER] on the transmitting calculator.

Note: You may need to rename or overwrite your variable for the file transfer to be
successful.

Note: Tl TestGuard™ App for the TI-83 Plus and TI-84 Plus is not designed to run and
transfer testing setups when loaded on a TI-Nspire™ handheld in TI-84 mode, including
the Re-Enable feature. Also, the blinking LEDs that indicate you are in Press-to-Test
mode do not blink when in TI-84 mode.
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General Information

Texas Instruments Support and Service

General Information: North and South America

Home Page: education.ti.com

KnowledgeBase and e-mail inquiries: education.ti.com/support

Phone: (800) TI-CARES / (800) 842-2737
For North and South America and U.S.
Territories

International contact information: education.ti.com/support/worldwide

For Technical Support

Knowledge Base and support by e-mail: education.ti.com/support or
ti-cares@ti.com
Phone (not toll-free): (972) 917-8324

For Product (Hardware) Service

Customers in the U.S., Canada, Mexico, and U.S. territories: Always contact Texas
Instruments Customer Support before returning a product for service.

For All Other Countries:

For general information

For more information about Tl products and services, contact Tl by e-mail or visit the
Tl Internet address.

E-mail inquiries: ti-cares@ti.com

Home Page: education.ti.com

Service and Warranty Information

For information about the length and terms of the warranty or about product service,

refer to the warranty statement enclosed with this product or contact your local Texas
Instruments retailer/distributor.
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